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Virtual Prototype: ARMulator

6. Virtual Prototype: ARMulator

6.1. Overview

Virtual prototype enables designer to verify the system early at a higher
abstraction level during the development. Virtual prototype can be
implemented using SystemC, SpecC, or other high level languages. In this lab,
we implement virtual prototype with ARMulator. ARMulator supports adding
user designed hardware model to simulate together with its ISS. This lab
demonstrates adding an RGB2YUV hardware model into ARMulator. This
high level hardware model is written in C using ARMulator’s hardware model
C constructs. You will learn the followings in this lab:

1. Be able to write and add C hardware model for ARMulator.

2. Learn how to write simple drivers for hardware.

3. Know system synchronization schemes: interrupt and polling

6.2. Background information

6.2.1. System synchronization

In order to let the IPs operate together with the system, synchronization
between the ARM core and the IPs is needed. Synchronization lets the
processor know when the assigned task of an IP is done, so the processor
knows when and where to acquire the results of an IP's task. There are two
basic synchronization schemes: interrupt and polling.

Interrupt:

An IP device signals an interrupt when it completes its tasks enabled by ARM
core. We say that the IP “raised an interrupt request (IRQ)”. This IRQ tells the
ARM core that it has finished its task, and requests to be handled.

Figure 1 shows the basic concept when several IPs raise interrupts at the
same time. The IRQs are sent to the interrupt controller. Then interrupt
controller will check if the IRQs are enabled; if so, it updates the IRQ status
registers within itself to indicate which devices requested IRQs. The sorted out
IRQ is sent to the ARM core to request the handling for the corresponding IP.
The ARM core will stop the current task at a proper time, determine which IRQ
should handled first according to programmed priority, and then backup the
current CPSR content to the SPSR, so it can resume the original task after
finishing handling the IRQ. If it is a nested IRQs, the content of the SPSR
would be pushed into the stack. The ARM core will issue the corresponding
interrupt service routine (ISR) by checking the interrupt status registers in the
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interrupt controller to determine which device requested the interrupt. The ISR
shall perform the corresponding operations and then clear the interrupt
request by writing a signal to clear interrupt signal of the corresponding IP,
which is IPO in this case. After the ISR is done, ARM core would pop the
CPSR’s original content and restore other related context to continue its
original task.

IPO, IP1, IP2, and IP3 raised interrupt
IPO 1P1 1P2 IP3 request (IRQ) at the same time. The
IRQs are sent to the interrupt controller.

A A A

Interrupt controller receives the IRQs
Interrupt Controller and update the IRQ status indicating the
IRQ sources.

ARM core receives the IRQs,
deteremines which IRQ should be
handled according to programmed
priorities. and then executes the
corresponding interrupt service routine

clear IPO's IRQ (ISR).
A

ARM CORE

The ISR performs its operations and

IP0 clears the IPO's interrupt.

Figure 1. A simple flow of how interrupt works.

Interrupt enables ARM core to continue working while the IP device has been
enabled. Yet the IRQ might be some how a little unpredictable since you don’t
know when the IP device would raise IRQ. Once an IRQ is raised, the core
must handle it with its ISR, this would interrupt the core’s original task. And
using interrupt requires an interrupt controller hardware unless there’s only
one device that would raise interrupt, which is often not the case.

Polling:

The ARM core keeps accessing a certain register in the IP which indicates
whether it has completed its task enabled by the ARM core for a certain time
interval. Once the IP has done its task, the register changes its value, so the
ARM core could know the IP is ready and the IP requires to be handled when
ARM core accesses the register. The action of continuous accessing and
checking the register with a certain time interval is called “polling”.

ARM core polls IPQ's ready register after
ARM CORE IPO has been enabled.

Once IP0 is done with its operation,
Polling IPO Disable IPO ARM core will know frgm the changed
value of the ready register.

ARM core will execute the
PO corresponding operations and then
disable IPO.

Figure 2. A simple flow of how polling works.
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Figure 2 illustrates the basic way polling is carried out. The ARM core enables
IPO and then keeps “polling” it. The ARM core checks the ready register of IPO
to see if it has finished its task. After IPO has done its task, the value of the
ready register would change to indicate it has finished its task. When ARM
core polls, it will know IP0 is done and can start the corresponding operations
after the completion of IPQ’s task. The ARM core will finish the corresponding
operations and disable IP0O. Once IPO is disabled, the ready register would
change to its original not-ready value.

Note that it's often not possible for ARM core to perform parallel operation
with the IP using polling since the core has to keep polling the IP device. And
it is up to the software program to determine when to handle the ready IP
device. The advantage of using polling is that no additional hardware is
required compared to using interrupt synchronization scheme.

6.2.2. ARMulator C hardware model

ARMulator supports IP designers to design their IP’s hardware model to run
simulations together. ARMulator is a cycle-accurate emulator, it consists of an
ARM core instruction-set simulator (ISS) program and several other peripheral
modules. New device can be designed with C/C++ language using certain
predefined functions interface for hardware modeling with ARMulator. The
design is built as dynamic link libraries (DLLs). By adding IP’s hardware
model’s DLL and modifying corresponding component description parameters,
the hardware model can be included into the simulation.

i Armulator : + Use the I/O facilities of
i the host computer,

1 FInstruction set .

' simulator i i instead of providing the i
i 3 Model instruction 1/O facilities i facilities on your target i

set and counts

t cydles E
i SInclude i
E communication i
i facilities with the !
i debugger ! debugger

=>Components :

E - ARM processor
! > memory system
! - peripherals
=>Debug monitor

- Angel or RealMonitor
= EmbeddedICE

=>»Embedded Trace Macrocell
hardware s :

Figure 3 Overview of ARMulator
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An ARMulator hardware model must include ARMulator basic model interface.
A basic model interface includes three parts:

1. Data structure declaration

2. Initialization

3. Finalization

Data Structure Declaration:
Data structure is declared wusing BEGIN STATE DECL() and
END STATE DECL () macros. Private data structure is declared as follow.
BEGIN STATE DECL (YourModel)
/*
* your private data here
*/
END STATE DECL (YourModel)

These macros declare a data structure:
Typedef struct YourModelState

This data structure includes your private data you put between the macros
and the following predefined data fields:

Toolconf config

Const struct RDI HostInterface *hostif

RDI ModuleDesc coredesc

RDI ModuleDesc agentdesc

Initialization
We use BEGIN INIT() and END INIT() macros to delineate the
initialization functions of the model. In the initialization function, your model
must initialize any private variable and install any callback. Two variables are
provided in the initialization:

- Bool coldboot

TRUE if ARMulator is initializing, FALSE if a new image is being

downloaded from the debugger.

- YourModelState *state

A pointer points to the private state data structure. Memory for this is
allocated and declared by the initialization macro, and the predefined
data fields are initialized.

Finalization

We use BEGIN EXIT () and END EXIT () macros delineate the finalization
function for the model. The finalization function is called when ARMulator is
closing down. The following local variable is provided in the finalization

function:
YourModelState *state

Your model must un-install any callbacks in the finalization function. The
END_EXIT () macro frees memory allocated for state.
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There are several useful ARMulator functions; you can refer to ARM Debug
Target Guide for further details on ARMulator hardware modeling.

6.3. Instructions

6.3.1. RGB2YUV ARMulator hardware model

The hardware model taken for example in this lab performs RGB2YUV
operation. In image processing, red, green, and blue signals are taken in from
CCD sensors. However, image encoder such as JPEG encoder adopts
luminance (Y) and two chrominance components (U, V) to represent image.
Therefore a transformation from RGB to YUV is necessary and is often the
first step taken in a JPEG encoder.

The formula to transform RGB to YUV is shown in the following equation:

Function:
Y 0.257 0.504 0.098 || R 16
C,|=1-0.148 -0.291 0439 |G |+[128
Cy 0.439 —-0.368 —0.071|l B 128
Table 1 Memory map of RGB2YUV
Address Read access Write access

RGB2YUV Control register
[31:2]: Reserved
[1]: done bit

RGB2YUV Control register
[31:3]: Reserved
[2]: clear interrupt bit

0: computation NOT done 0: do nothing
RGB2YUV_base 1: computation done 1: clear interrupt
[0]: enable status register [1]: Reserved
0: disabled [0]: enable register
1: enabled 0: disable
1: enable
Red input register Red input register
RGB2YUV_base + 0x04 [7:0]: Red value [7:0]: Red value

RGB2YUV_base + 0x08

Green input register
[7:0]: Green value

Green input register
[7:0]: Green value

RGB2YUV_base + 0x0C

Blue input register
[7:0]: Blue value

Blue input register
[7:0]: Blue value

RGB2YUV_base + 0x10 |Y output register Reserved
[7:0]: Y value

RGB2YUV_base + 0x14 |U output register Reserved
[7:0]: U value

RGB2YUV_base + 0x18 |V output register Reserved
[7:0]: V value

%5 3% SoC % | #ci4
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The transform is a 3x3 matrix multiplication and addition. The hardware is
assumed to have 3 multipliers and 3 adders, hence 3 cycles are needed to
complete a transformation from RGB to YUV. The memory map for this device
is listed in Table 1. The based address is set at 0xC2100000 and each
register is word aligned.

The procedure of using RGB2YUV is illustrated in Figure 4. A master (ARM or
DMA) first load the RGB values by writing Red, Green, and Blue register at
offset 0x04, 0x08, and 0x0C. After loaded the data to be processed, the
master writes 0x01 to Control register at RGB2YUV base address, which is
0xC2100000. By writing 1 to bit O (enable register), RGB2YUV starts
computing. Upon completion, the interrupt signal would be set and done bit in
Control register would be set also. If synchronization is carried out using
interrupt, corresponding ISR for this interrupt will clear the interrupt and
disable the device, some may also retrieve the data to a target position. The
function call graph of RGB2YUV is illustrated in Figure 5.

ARM Processor (Master)

Load RGB values to RGB2YUV

Enable RGB to YUV by writing 0x01 to

Control register
RGB2YUV (Slave)
>

Idle FOR loop, the processor can do
other tasks while HW is running

= RGB2YUV done, generate IRQ, set Done bit in Control register

IRQ detected, branch to ISR. ISR clears the interrupt and disables RGB2YUV.
Copy RGB2YUV result to memory if necessary.

N

Figure 4 Procedure of using RGB2YUV

| RGB2YUV_Access |

BusState

| TICRegisterAccess |

v

| TICEnableRegisterWrite |

RGB2YUVCIearInterrupt| | KickOffRGB2YUV |

| RGB2vUVDone |

Figure 5 Function call graph in RGB2YUV C hardware model

6-6 %5 ¥% SoC B p % i4



Virtual Prototype: ARMulator
6.3.2. Building hardware model using VC++’s NMAKE

1. Search for vevar32.bat using WinXP’s file search utility.

2. In WinXP, Program Files>Accessories>Command Prompt, a
command prompt window appears.

3. Execute vcvar32 in the command prompt. This sets the environment for
Microsoft Visual C++ NMAKE utility.

4. Copy RGB2YUV.c into SARM_INSTALL_DIR\Bin, $ARM_INSTALL_DIR
is the install directory of ARM ADS. For PCs in ED414,
$ARM_INSTALL_DIR is C:\Program Files\ARM\ADSv1_2 .

5. Copy directory RGB2YUV.b into
S$ARM_INSTALL_DIR\ARMulate\armulext . There is an intelrel directory
within this directory, a Makefile is provided in intelrel.

6. Change current directory in command prompt to
SARM_INSTALL_DIR\ARMulate\armulexttRGB2YUV.b\intelrel .

7. Type nmake in command prompt to make the hardware model dynamic

link library. The dynamic link library file is RGB2YUV.dII, it is located in

intelrel after nmake is completed.

Copy RGB2YUV.dIl from intelrel to SARM_INSTALL_DIR\Bin

Create RGB2YUV.dsc in $ARM_INSTALL_DIR\Bin with the following

content.

;7 ARMulator configuration file type 3

{ Peripherals

{RGB2YUV
MODEL DLL FILENAME=RGB2YUV

© ©

}
{
No RGB2YUV=Nothing
}
}

.‘IO.Modify default.ami in $ARM _INSTALL DIR\Bin, add RGB2YUV part
below timer part.
{ Timer=Default Timer

}

{ RGB2YUV=Default RGBZ2YUV
}

11.Modify peripherals.ami in SARM_INSTALL_DIR\Bin, add RGB2YUV part
below timer part.

{Default RGB2YUV=RGB2YUV

Range:Base=0xC2100000

}

12.0pen RGB2YUV_demo.mcp project file with CodeWarrior. This project
tests RGB2YUV hardware.

13.Make the project and run. The execution results should be the same as
follow.
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ARMTTDMI - Conzole

HW: BGEZ¥UY Bed write.
HW: BGEZVUV Green write.
HW: RBGEZYUY EBlue write.
SW: Write E=0 G=0 E=0
HW: RGE=YUV Eed read.

W: Fead E_t=0
HW: RGEZYUV Green read.
4 Read G_t=0
HIW: BGEZYUV Blue read.

3W: Read B_t=0
HIWl: RGEZVUV Control write.
BGE2YUVW Kicked off.
EGEZYTYV done.
REGEZYTY Control write.
RGEZYUY irg cleared.
BGE2YUV diabled.

3W: TRO_handler clears irg and disablez RGEZYUV
FHESEEdEASaEEd R #end

6.3.3. Building & debugging hardware model using VC++

1. Copy RGB2YUV.c into $SARM_INSTALL_DIR\ARMulate\armulext. Skip
this step if you've already done so.

2. Copy directory RGB2YUV.b into
$ARM_INSTALL_DIR\ARMulate\armulext. Skip this step if you've
already done so.

3. Make sure RGB2YUV.dsc is added, also make sure default.ami and
peripherals.ami are modified as shown in step 70 to step 11in 6.3.1..

4. Start Microsoft Visual C++ 6.0

5. File=>New to create a new empty project with the following settings. Press
OK when you are done.

Project Type: Win32 Dynamic-Link Library
Project Name: RGB2YUV
Location: C:\Program FilesS\ARM\ADSv1_2\ARMulate\armulext\
RGB2YUV.b
6-8 35 % SoC B #it
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Files

Projects | Workspaces

Other Documents

L] ATL COM AppWizard
=|Cluster Resource Type Wizard
=] Custom AppWizard
‘=Database Project
2 DevStudio Add-in Wizard
W2 ISAPI Extension Wizard
i7<] Makefile

MFC ActiveX Control\Wizard
[#] MFC AppWizard [dIl]
MFC AppWizard [exe]
§ Utility Project
®|Win32 Application
~]Win32 Consaole Application

Project name:
|rRGB2YUY

Location:
IC:'F,PROGRAM FILESVARMIWADSV1 ;_J

* Create new workspace

{7 Add to current workspace

|%]Win32 Dynamic-Link Library |
%] Win32 Static Library
Platforms:
[Vwin32
OK | Cancel ‘
6. Project?Add To Project>Files to add following files into
SARM_INSTALL_DIR\ARMulate\armlext to the project
RGB2YUV.c
sordi.def
version.rc
7. Project>Settings... or press ALT+F7 to open project settings window.
8. Make sure the drop down list at the top-left displays Win32 Debug. If not,
select this option.
9. Click Debug tab, choose category "General" from the drop-down menu.

Type $ARM_INSTALL_DIR\bin\axd.exe

session field.

in Executable for debug

7 3% SoC B B ¥t
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Project Settings

Settings For: |Win32 Debug _v_| General Debug | ClC++ I Link | Resources | Mi E]I

Category: IGeneraI ;l

Executable for debug session:

|C:'-,Prugram Files\ARMVADSv1 _2\Binlaxd.exe ;l

Working directory:

Program arguments:

Remote executable path and file name:

OK | Cancel

10.Click C/C++ tab, choose category "General" from the drop-down menu. In
Project Options box, change /MTd to /MD.

Project Settings

Settings For: |Win32 Debug j General I Debug CjC++ | Link | Resources | ME: EI

|
Category: !General LI Reset

YWarning level: Optimizations:

Level 3 ~|  |pisable [Debug) -
[~ WWarnings as errors [~ Generate browse info
Debug info:

IPrugram Database for Edit and Continue j

Preprocessor definitions:
iWIN32,_DEBUG,_WINDOWS,_MBCS,_USRDLL.RGBEYU\

Project Options:

fologo {MD W3 JIGm JGX [Z] {Od D "WIN32" {D R
" DEBUG" /D "_WINDOWS" /D" _MBCS" D =
" USADLL" /D "RGB2YUY_EXPORTS"

| £

OK | Cancel

11.In C/C++ tab, choose category "Preprocessor" from the drop-down menu.
Specify ..\.\.\rdi, .\.\.\clx, ..\.\.\armulif in Additional include

directories field

6-10 #5737 SoC 5 p &4
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Project Settings

Settings For: |Win32 Debug L' General I Debug C{C++ | Link I Resources | M? Ez

Category: ;Prcpmcessur ;’ Reset |

Preprocessor definitions:
iWIN32,_DEBUG,_‘WINDOWS,_MBCS,_USRDLL.RGBEYU‘I.

Undefined symbols: " Undefine all symbols

Additional include directories:
|..'1...'-...'l.rdi,..\..‘...‘.clx,..\..'-.. Aarmulif

[ Ignore standard include paths

Project Options:

fnologo {MD A3 JGm fGX 21 fOd I "4 N Ardi™ ) ™~
bk AL Sarmulif /D 'WINS2Y DY DEBUGH
{0 " WINDOWS" /D" _MBCS" fD " USRDLL" /D

%

OK | Cancel

12.Click Link tab, choose category "General" and replace the contents of
Object/library modules field
with: ..\..\.\cIx\cIx.blintelrel\cIx.lib ..\..\..\armulif\armulif.b\intelrel\armuli
f.lib. Type $ARM_INSTALL_DIR\Bin\RGB2YUV.dIl. Close Project
Settings after you complete configuring the project.

Project Settings

Settings For: |Win32 Debug L' General I Debug | ClC++ Link I Resources | M? Ez

Category: !Gcneral ;’ Reset |

Output file name:
lC:'-,F'rugram Files\ARMIADSw1 2YBil\RGB2YUVY.dII

Objectflibrary modules:
l..'1...'-...'-.clx'l.clx.h'-.intt:lrt:I'-.clx.lih JdGarmulifarmulif.bhintelre

¥ Generate debug info [ Ignore all default libraries
¥ Link incrementally [~ Generate mapfile

[~ Enable profiling [~ Doesn't produce .LIB

Project Options:

G dckdck blintelrehelx.lib i
Ao darmulifarmulif.byintelreNarmulit.lib fnologo {dil |
fincremental:yes lpdb"Debug/RGB2YUY.pdb" /debug =

OK | Cancel

13.Build the project by Build=>Build RGB2YUV or by pressing F7. This
generates RGB2YUV.dIl at SARM_INSTALL_DIR\Bin\ .
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14.0pen RGB2YUV.c source code file and set break points at following
lines: 211, 226, 248, and 306 by pressing F9 at the lines.

static void RGB2YUUDone{void *handle)

{
[ ] RGB2YUUState =ts = (RGB2YUVState=x)handle;
rgb2yuu_state =*=mysehw = &ts->RGE2YUU;
Hostif_ConsolePrint(ts->hostif,” HW: RGE2YUU done.\n");
ARMulif_SetSignal{ &{ts->coredesc), RDIPropID_naRHMSignal_IRQ, Signal_On );

F*

Function Hame: RGE2YUUClearInterrupt

Paremeters: RGB2YUUState =ts

Return: void

Description: Clears the interrupt source

=/

static void RGBZ2YUUClearInterrupt{RGB2YUUState =ts)

{
@ ARMulif_SetSignal{ &(ts->coredesc), RDIFropID_nRMSignal_IRQ, Signal_OFF );
Hostif_ConsolePrint({ts->hostif,"” HW: RGB2YUU irq cleared.\n");

F*

Function Hame: TICEnableRegisterWrite

Parameters: RGB2YUUState =ts,
rgb2yuu_state *=myRGB2YUU,

ARHword =word  pointer to data to use for write.

Return: int - always return @

Description: Breakout function for TICRegisterficcess - the final address decoder - to
keep the complexity of one function down a little to keep it readable - this
is hand generated not auto-generated code.
This function performs the processing for a write to the RGB2YUU control
registers. It updates the mirror struct members such as enabled/prescale.
It processes changes to enable and prescale.

e

static int TICEnableRegisterWrite{RGE2YUUState =*ts, rgb2yuv_state =myRGB2YUV, ARMword =word)

/= Update the internal representation first =/
@ myRGB2YUU->RGB2YUUEnableChangetask = (getBit(myRGBZVUU—)RGBZVUU_Bontrol,l]))“(getBit(*word,l]));
myRGB2¥UU->RGE2YUV_Control = =word&@xAB000865; // Only the least 3 bits are significant : Clear, Done,
/7 Only bit 2 and @ can be written

then the access is passed on to the next level of memory by switch.

=/
static int TICRegisterfnccess(RGB2YUUState xts,ARMword addr,nRHword »*word, unsigned /=*ARMul_acc=/ acc)
{

unsigned long maskedfddress = addr & Bx0@880883F;
#tifdef UERBOSE

printf{"TICRegisterAccess: A:%A81x D:%@8B1lx.\n",{unsigned long)addr,

(word==NULL)?BUL:(unsigned long)*uword);

ftendif

/* Yes it is a memory access - now is it a read or a write? =/
@ if { ACCESS_IS_READ(acc) )}
{
/= Read from registers =/
switch { maskedAaddress)

{

case Bx00: //RGB2YUU Control
// Only the least 3 bits are significant : Clear, Done, Enable
=word = ts->RGE2YUU_RGB2YUU_Control & Bx00000007;
break;

case Bx04: // read red
//Hostif_ConsolePrint{ts->hostif,"read ");
Hostif_ConsolePrint(ts->hostif,” HW: RGB2YUV Red read.\n");
=word = ts->RGE2YUU._RGB2YUU_Red;
break;

15.Press F5 to in VC++ 6.0 to launch AXD and ARMulator. Load
RGB2YUV_demo.axf in AXD. Run the AXD image, when RGB2YUV
hardware model is triggered, the process will halt at the break points set in
step 14.

16.Observe how the hardware model works. By using VC++, you can debug
much easier and faster. On occasion without VC++, you’ll have to dump
out internal information using Hostif ConsolePrint routine

6-12 %7 3% SoC 5 P



Virtual Prototype: ARMulator
6.4. Exercise

Add a new hardware (Matrix Transpose, MT) model. This hardware
transposes a 2x2 matrix. The input row data are changed into output column
data (A=B").Each data is to be 8-bit data. This operation is assumed to take 2
cycles. The base address is 0xC2110000. Name your module as MT and the
name of the source code as MT.c.

Then write a simple test program to test your hardware model.

Please explain your memory map and source code to TA while demo.

Refer to ARM Debug Target Guide for ARMulator function definitions.

Hint: you can first replace RGB2YUV with MT, replace rgb2yuv with mt.
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6.5. Reference

1. ARM Application Note 32: The ARMulator [DAIO032E]
2. ARM Debug Target Guide [DUIO058D]
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6.6. Appendix

There are four most common functions we use in this lab. They are
ARMulif_Time(), ARMulif_ScheduleUntractable(), ARMulif_SetSignal()
and Hostif _ConsolePrint().

ARMulif_Time:

This function returns the number of memory cycles executed since
system reset. The syntax of this function is:

ARMTime ARMulif Time (RDIModuleDesc *mdesc)
mdesc is the handle for the core.

ARMulif_ScheduleUntractable :
This function is used to schedule a function to be executed after certain
cycles. The syntax of this function is:

void ARMulif ScheduleUntractable (RDI ModuleDesc *mdesc,
ARMul TimedCallBackProc *func,
void *handle, ARMTime when,
ARMTime period)

func is the function to be executed. when is the time for the function to be
executed.

ARMulif_SetSignal:
This function is used to set the state of signals or properties. The syntax
of this function is:

void ARMulif SetSignal (RDI ModuleDesc *mdesc,
ARMSignalType sigType, SignalState
sigState)

sigType is the signal to be set. sigState is either on or off.
Hostif _ConsolePrint:

This function is used to print some variables in ARMulator via RDI to the
console window. The syntax of this function is:

void Hostif Consoleprint (const struct RDI HostosInterface
*hostif, const char *format, .. )
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hostif is the handle for the host interface. format is a pointer to a printf-
style formatted output string. ... are a variable number of parameters

associated with format. For example:
Hostif ConsolePrint (state->hostif, "result=%d \n", result);
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